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Stock charts, as the name indicates are useful to show fluctuations in stock prices. However, these charts are useful to show fluctuations in other data also, such as daily rainfall or annual temperatures.If you use a Stock chart to display the fluctuation of stock prices, you can also incorporate the trading volume.For Stock charts, the data needs to be
in a specific order. For example, to create a simple high-low-close Stock chart, arrange your data with high, low, and close entered as column headings, in that order.Follow the steps given below to insert a Stock chart in your worksheet.Step 1 Arrange the data in columns or rows on the worksheet.Step 2 Select the data.Step 3 On the INSERT tab, in
the Charts group, click the Stock, Surface or Radar chart icon on the Ribbon.You will see the different types of available Stock charts.A Stock chart has the following sub-types High-Low-CloseOpen-High-Low-CloseVolume-High-Low-CloseVolume-Open-High-Low-Closeln this chapter, you will understand when each of the Stock chart types is
useful.High-Low-CloseThe High-Low-Close Stock chart is often used to illustrate the stock prices. It requires three series of values in the following order- High, Low, and then Close.To create this chart, arrange the data in the Order - High, Low, and Close.You can use the High-Low-Close Stock chart to show the trend of stocks over a period of time.
The Open-High-Low-Close Stock chart is also used to illustrate the stock prices. It requires four series of values in the following order: Open, High, Low, and then Close.To create this chart, arrange the data in the order - Open, High, Low, and Close.You can use the Open-High-Low-Close Stock chart to show the trend of STOCKS over a period of
time.Volume-High-Low-CloseThe Volume-High-Low-Close Stock chart is also used to illustrate the stock prices. It requires four series of values in the following order: Volume, High, Low, and then Close.To create this chart, arrange the data in the order Volume, High, Low, and Close.You can use the Volume-High-Low-Close Stock Chart to show the
trend of stocks over a period of time.Volume-Open-High-Low-CloseThe Volume-Open-High-Low-Close Stock chart is also used to illustrate the stock prices. It requires five series of values in the following order: Volume, Open, High, Low, and then Close.To create this chart, arrange the data in the order - Volume, Open, High, Low, and Close.You can
use the Volume-Open-High-Low-Close Stock chart to show the trend of stocks over a period of time. Skip to content In this Excel charting tutorial, you will learn how to make a stock chart in Excel. You can use such a graph everytime you have open, high, low, close data values. Stock data preparationYour data should include the stocks name, date,
and the stock prices. Organize your data with the following columns: Date, Open, High, Low, and Close.Note: The specific columns you need may vary based on the type of stock chart you plan to create. Common data arrangements include high, low, and closing price, or volume traded, high, low, and closing price. Another option is to include volume,
open, high, low, and closing price.Highlight the Open, High, Low, and Close columns, then click on Quick Analysis.Inserting a stock chartClick charts, and then press More.Select the type of stock chart you want to create.Right-click on legends, and click select data.Click edit on horizontal.Choose stocks names.Press ok.The chart will be inserted into
your worksheet.You can format the chart to your liking by adding a title, changing the axis labels, or adjusting the colors.Here you can download free template of Stock Chart. See also How to create a chart with grouped data? Heres an overview of a box and whisker plot and a surface chart in Excel for stocks. Download the Practice Workbook Stock
Chart in Excel.xIsx What Is a Stock Chart?A stock chart illustrates the historical price development of a particular stock or resource over a specific period of time. This type of chart shows the trend of a stocks performance over time. What are Open, High, Low, and Close Prices in a Stock Chart?The opening price is the price at which a stocks trading
starts at the beginning of a particular time period, like a trading day.The high price indicates the highest price a stock may be purchased for within the given time frame, which could be a trading day, an hour, or any other period of time.The low price represents the stocks lowest price within the given time period.The closing price is the final price at
which a stocks trading ends at the end of the specified time period.Lets look at the stock chart below. The highest point represents the high price, and the lowest point represents the low price. The difference between the open and close prices is shown in a bar plot. The opening price can be lower than the closing price. Create a Stock Chart in Excel:
4 Different CasesWe will be using the following dataset as an example to demonstrate those all. The dataset represents Amazon.coms volume, open, high, low, and close prices for a specific time period. Case 1 High-Low-Close Stock ChartSelect the ranges B5:B21 and E5:G21 holding the Ctrlkey.Go to the Insert tab, then choose Insert Waterfall,
Funnel, Stock, Surface, or Radar Chart.Click on High-Low-Close.The chart will appear on your worksheet, but it needs to be formatted.Select the Chart Title and type down your desired title. We have set the title of our chart as Amazon High-Low-Close Stock Chart.Double-click on the chart. A separate window titled Format Chart Area will appear on
your worksheet.Click on Chart Options.Select Series Close.Click on Fill & Line.Select Marker.Click on Marker Options.Check Built-in.Left-click on the Type drop-down menu.Select the cross symbol as shown below.Increase the size. We have increased it to 7.From the Border section, select an appropriate color. We have selected an orangecolor.All the
cross points within the chart represent the Closing prices.The highest point represents the high price and the lowest point represents the low price. Case 2 Open-High-Low-Close Stock ChartSelect the range B5:B21 and the range D5:G21 together holding the Ctrlkey.Go to the Insert tab.Select Insert Waterfall, Funnel, Stock, Surface, or Radar
Chart.Choose Open-High-Low-Close.The following stock chart will be created.Double-click on the chart, and the Format Chart Area sidebar will appear on your screen.Select Series Open from the Chart Options.Go to Fill, Marker, Marker Options, Built-in, and choose the circled symbol.Select any color you want.Click on Series Optionsthen select
Series Close.Go to the Fill & Lineoption.Click on Marker.Select Marker Options.Mark Built-in.Select the cross symbol from the Type drop-down.Select a convenient color.The chart will be more understandable. Case 3 Volume-High-Low-Close Stock ChartSelect ranges B5:C21 and E5:G21 from the dataset.Go to the Insert tab and select Insert
Waterfall, Funnel, Stock, Surface, or Radar Chart.Pick Volume-High-Low-Close.The chart will appear on your sheet. The clustered column bars represent the volume of stock.From the Format Chart Area sidebar, select Chart Options.Select Series Close.In Marker options, choose the built-incross symbol.Set the size to at least 8.Select any color.The
chart looks as follows. Case 4 Volume-Open-High-Low-Close Stock ChartSelect the range B5:G21.In the Insert Waterfall, Funnel, Stock, Surface, or Radar Chart drop-down, selectVolume-Open-High-Low-Close.The following stock chart will appear on your screen.Double-click on the chart.From the Format Chart Area, click on Chart Options.Select
Series Open.Go to Marker Options,select Built-in and select a circle.Select any color.Click on the Series Optionsdrop-down menu.Select Series Close.Select a cross-shaped Marker.Choose a convenient color.The chart will look something like the following image.Lets put the Volume as a line instead of a clustered column bar.Right-click on any Volume
column.Click on Change Series Chart Type.Click on the Volume drop-down menu.Select Line.Click on OK.Heres how the chart looks with the volume line.Lets add a trendline for closing prices.Select any close price point from the chart. Here in the chart, all the cross points represent closing prices.Click on the plus (+) icon at the top-rightmost of your
chart.Click on the arrow sign beside Trendline.Select More Options.The trendline is added as follows.Read More: How to Create Stock Comparison Chart in Excel Create a Box and Whisker Plot in ExcelSelect the range B5:E21.Go to the Inserttab.Click on the Insert Statistic Chartmenu.Select Box and Whisker.The graph will appear on your sheet.Click
on plus (+)icon.Click on the arrow symbol next to Legend.Select Bottom.The Legend is added to the bottom of your chart as follows. Create a Surface Chart in ExcelSuppose we have a dataset of product sales. We want to create a surface chart out of it.Select the range B4:E9.Go to the Inserttab.Click on Insert Waterfall, Funnel, Stock, Surface, or
Radar Chartmenu.Select 3-D Surface.The surface chart is created as follows. Things to Remember While Creating a Stock Chart in ExcelWhile creating any type of stock chart in Excel, you have to follow the sequence of values:Volume > Open > High > Low > CloseVolume > High > Low > CloseOpen > High > Low > Close High > Low > Close.
Frequently Asked QuestionsCan I create a dynamic stock chart that updates automatically with new data?Yes, you can create a dynamic stock chart that updates automatically with new data. You may use named ranges and tables in Excel to create a dynamic stock chart. The chart will automatically update as new data rows are added to the table if
you create a named range for your data and turn it into a table.What is the best chart type for displaying stock price trends?The type of chart you choose will depend on your preferences and the type of your data. However, OHLC (Open-High-Low-Close) is usually the most used type for creating a stock chart.Can I customize the appearance of my
stock chart in Excel?Excel provides tools for customizing the colors, fonts, gridlines, and other visual components. Options In the dialog box that opens up, go to Advanced and Edit Custom List, as shown:This opens a pop-up from where you can import the list from the table as shown:Click OK in the Excel options dialog box, then go to chart to check if
the order has changed. If not, then click on the chart and open slicer settings from the top-left (refer to step 09) and change the order to descending and then back again to ascending.Descending:Ascending:With this, our ordered slicer looks as below, which when changed, automatically changes the chart based on the chosen interval.In this and the
following steps, our focus in on displaying the Min/Max price points on the line chart.To do this, we need to add additional columns to the data.The MIN, ideally should be the minimum value of the price from our price column (R_PRICE). The formula for the same will be:=IF(R PRICE=MIN(R PRICE),R PRICE,NA())In the same way, the MAX will be
the maximum value of the price from our price column (R PRICE). The formula for the same will be:=IF(R_ PRICE=MAX(R PRICE),R PRICE,NA())With these additional columns, our new data would be:Since with the remaining columns, the MIN/MAX are dynamic, well assign named ranges for these as well. Do so by clicking on the first cell of Min
value, N3 and go to Formulas -> Define Name.Here, to make the rows dynamic, include a # at the end of the cell reference and assign a name, say R MIN.Similarly, assign a name to the Max series, R MAX as shown below:Now,lets add these newly created series to the chart. Right-click on the chart and select data. From the dialog box that appears,
add a new series as shown below:Edit the horizontal axis as well:Here, since the horizontal axis is dates, use the R DATES named range created for the same.Once this is done, the data select dialog box should look like this:In the same way, add the MAX series as well and edit the horizontal axis too.Note: Here, in my Excel, Demo is the sheet where
my chart and its data are present. Use your sheet name followed by a ! accordingly. To correctly add this, click on any blank cell and delete till the ! and then add your named range.As anext step, right-click on the chart and go to Change chart type.In combo, modify the chart type as shown below:With this change, our chart with min/max points takes
shape and looks as below:To make this into a desired format, click on the chart and press CTRL+1 to open the format pane.In the drop-down, choose the MIN series.In fill & line, choose No Line option.In the Marker options, choose a built-in circle style marker and increase the size, assign a suitable color to depict a min value.Repeat the same steps
for the Max series by choosing it from the format pane drop-down. Edit the markers accordingly.After adding and formatting the min/max points, let us now add labels to this. From the drop-down choose the Min series and from the + icon on chart add data labels and go to More options:Here, include the categories as well to be displayed in a new
line and since this is a Min point, position the label below.Now, choose the Max series, add the data labels and position them above with the category name.Try changing the dates, and the intervals and see the chart dynamically update with min/max points.Till now, we have created the price history chart, and added the interactive, dynamic interval
slicer and the min/max points.In the next few steps, let us create the interactive time period slicer to choose the look-back period for your chart.Lets get to the helper sheet (refer step 07) where weve created a pivot table. Here, add the necessary time period data and covert the same into a table (CTRL+T).Here the periods are: five days (5D), month-
to-date (MTD), one month (1M), three months (3M), six months (6M), year-to-date (YID), 1 year (1Y) and 5 years (5Y).Similar to Step 07, create a pivot table for this period data in the same sheet.Click inside the pivot table, from Insert -> add Slicer.Based on the Slicer selection cell B30 records the same. Assign a name to the same as I PERIODBased
on the period selection, the starting date needs to be changed accordingly for our chart to use.For each of the 5D, MTD, 1M etc let us see how to use some Excel functions to achieve it.First, enter the current date (=TODAY()) and assign a name to this as TD.The start date for each of the period can be achieved as follows:5D: This will be today minus
four days, in cell D18 the formula would be=TD-4MTD: Use EOMONTH to get the end of previous month and add 1 to get to the next date i.e. the beginning of the current month, in cell D19 the formula would be=EOMONTH(TD,-1)+11M: Use EDATE to go back exactly 1 month from today i.e TD, in cell D20 the formula would be=EDATE(TD,-1)3M:
Similar to 1M, use EDATE and go back three months, in cell D21 the formula would be=EDATE(TD,-3)6M: Same as 1M and 3M, use EDATE, in cell D22 the formula would be=EDATE(TD,-6)YTD: Use a combination of DATE and YEAR functions to get the first date of the current year, in cell D23 the formula would be=DATE(YEAR(TD),1,1)1Y: Here,
well use EDATE to go back 12 months, in cell D24 the formula would be=EDATE(TD,-12)5Y: Similar to above, go back 60 months using EDATE to represent 5 years=EDATE(TD,-60)With these formulas, the corresponding start dates for the various periods are as shown:With the list of potential start dates, let us use the SWITCH function and the

I PERIOD assigned name to get the date corresponding to the period slicer selection.That is based on the selection from I PERIOD, the SWITCH function needs to return the corresponding start date value. (Refer to the syntax for SWITCH in step 08).In cell F17, the formula would

be:=SWITCH(I PERIOD,"5D",D18,"MTD",D19,"1M",D20,"3M",D21,"6M",D22,"YTD",D23,"1Y",D24,"5Y",D25,D22)Lets assign this date a name, say C_START DATE before we proceed to tie this to our chart.Go back to the sheet where we have the chart, and change the Start date (which we have manually entered so far) to =C_START DATE.Cut the
period slicer (CTRL+X, from the helper sheet) and paste it (CTRL+V) into the sheet with the chart. Similar to step 09, let us format the slicer to be more visually appealing.Also, remove the slicer header (refer step 09) and position it on top of the chart as needed.Now, similar to changing the order of the appearance of slicer items in the interval slicer
in step 10, well do the same and get a custom list for the period slicer. Follow the steps in the step 10 for the Period table data and include a custom list as shown:If the slicer is not changed to the right order, go to slicer settings, and change the sorting order to descending and back to ascending order.Test with a new stock symbol and apply the
interval and the period slicer to get the chart updated accordingly. By the end of this step, your chart should look something like this:In the final leg of building our interactive and dynamic Stock Price History chart, the next few steps will focus on building the volume bars in the chart. Well have additional columns for the green and red volume
columns.Since well use the Volume column here, let us assign a name for this (as we did earlier for dynamic arrays, refer step 03). Please note that the Date, Closing price, and Volume data come from a single formula from cell K3. So, click on K3, and in the Formula ribbon, go to Define Name and assign R VOL to the volume column.Now the formula
for the GREEN VOL column should check the current rows price and if it is greater than that of the previous rows then this comes under green volume otherwise, well return an NA.=IF(R PRICE>OFFSET(R PRICE,-1,0, ROWS(R_PRICE)),R VOL,NA())Similarly, if the price is less than the previous price, we get the RED VOL.=IF(R_PRICE Stock> Stock
Volume-Open-High-Low-Close.Right-click on the chart and choose Change Chart Type.Select Waterfall > Stock and then Open-High-Low-Close which is the candlestick pattern from the available options.Click OK to apply the changes. To add a moving average: Right-click on the chart and select Select Data.Click Add to create a new series.Name the
series (e.g., 20-day MA). Use an Excel formula to calculate the moving average for your closing prices. Select the range containing your moving average calculations for the Series values. To add a trend line: Navigate to Chart Design in the Excel ribbon Click Add chart element and select Trendline from the context menu.Choose the type of trendline
you want to add (e.g., Linear, Exponential).Customize the trendlines appearance and options as needed. To compare multiple stocks: Organize data for each stock in separate columns. Select all the data you want to include. Insert a stock chart as usual. Excel will automatically create separate series for each stock. Customize colors and labels to
distinguish between stocks. For automatic updates: Try the Free Spreadsheet Extension Over 500,000 Pros Are Raving About Stop exporting data manually. Sync data from your business systems into Google Sheets or Excel with Coefficient and set it on a refresh schedule. Get Started Use dynamic named ranges to automatically include new data.
Create a macro to refresh data sources and update charts: a. Open the Visual Basic Editor (Alt + F11). b. Insert a new module and add this code: vbaCopySubUpdateStockCharts() ActiveWorkbook.RefreshAll ActiveSheet.ChartObjects(YourChartName).Activate ActiveChart.Refresh EndSub Assign the macro to a button or set it to run automatically on
workbook open. Stock charts are specialized graphs designed to display financial data, particularly the price movements of stocks over time. They provide a visual representation of a stocks performance, making it easier to identify trends, patterns, and potential investment opportunities. A stock chart is a graphical representation of a stocks price
movements over a specific period. It typically includes information such as the opening price, closing price, highest price, and lowest price for each time interval (e.g., day, week, or month). Excel offers several types of stock charts to suit different analysis needs: Open-High-Low-Close (OHLC) charts: Display four data points for each time interval the
opening price, highest price, lowest price, and closing price. High-Low-Close (HLC) charts: Similar to OHLC charts but omit the opening price. Volume-High-Low-Close charts: Combine price information with trading volume data. Candlestick charts: Provide a more detailed view of price movements, using candles to represent the open, high, low, and
close prices. Stock charts are invaluable tools for: Analyzing historical price trends Identifying potential buy or sell signals Comparing the performance of multiple stocks Visualizing the impact of market events on stock prices Communicating financial data to stakeholders or clients Excel offers tools for creating stock charts, but financial analysis
often requires up-to-date data from various sources. Coefficient connects your spreadsheets directly to financial data systems. This allows you to import live stock data, create real-time financial reports, and automate chart updates in Excel. To see how this can streamline your stock analysis, try Coefficient. Stock charts are a crucial tool for investors
and financial analysts to analyze and visualize stock data. They provide a clear and visual representation of a stock's price movement over time, helping to identify trends and make informed decisions. In this tutorial, we will walk you through the process of creating a stock chart in Excel, allowing you to effectively track and analyze stock
performance.Key Takeaways Stock charts are essential for analyzing and visualizing stock data, providing a clear representation of price movement over time. Creating a stock chart in Excel allows for effective tracking and analysis of stock performance. Understanding stock data in Excel involves importing and formatting the data for charting
purposes. It is important to select the right chart type and customize it to fit your data and preferences. Analyzing and interpreting stock charts can help in identifying trends and making informed investment decisions.Understanding stock data in Excel When creating a stock chart in Excel, it is important to first understand how to import stock data
and properly format it for charting. This will ensure that your stock chart is accurate and visually appealing. A. Importing stock data into ExcelBefore creating a stock chart, you need to import the stock data into Excel. This can be done by using the "Stocks" data type feature in Excel. Simply select the cell where you want the stock data to appear,
then go to the "Data" tab and click on "Stocks" to pull in the stock data. B. Formatting the data for chartingOnce the stock data is imported into Excel, it is important to format the data in a way that makes it suitable for creating a stock chart. This may involve organizing the data into columns, ensuring that the date and stock price data are correctly
formatted, and removing any unnecessary information.Selecting the right chart type When it comes to visualizing stock data in Excel, selecting the right chart type is crucial to effectively communicate the information. Here are a few key points to consider: Excel offers a variety of chart options, including line charts, bar charts, and scatter plots. Each
chart type has its own strengths and limitations, so it's important to explore the different options to determine which one best suits the stock data you want to visualize. For stock data, a common and effective chart type is the stock chart, which is specifically designed for displaying stock prices over time. A stock chart, also known as a stock price
chart, is ideal for visualizing the open, high, low, and close prices of a stock over a specific period. It allows for easy comparison of stock performance and trends, making it a valuable tool for investors and analysts. Stock charts also typically include volume data, providing additional insight into the trading activity of a particular stock.Creating a stock
chart When working with financial data, it is essential to have a clear and visually appealing representation of stock data. Excel provides a convenient tool to create stock charts, allowing you to analyze and present stock trends effectively. A. Step-by-step guide on inserting a stock chart in Excel Step 1: Open your Excel workbook and navigate to the
worksheet containing your stock data. Step 2: Select the range of data that you want to include in the stock chart. This typically includes the date and stock price information. Step 3: Go to the "Insert" tab on the Excel ribbon and click on the "Stock Chart" option in the Charts group. Step 4: Choose the appropriate stock chart type, such as "High-Low-
Close" or "Open-High-Low-Close," based on your data and preference. Step 5: The stock chart will be inserted into your worksheet, and you can further customize it to suit your needs. B. Customizing the chart to fit your data and preferences 1. Adjusting axis and data series: Right-click on the chart and select "Format Chart Area" to modify the axis
labels, data series, and other elements to accurately represent your stock data. 2. Adding trendlines and annotations: Enhance the stock chart by including trendlines, annotations, or additional data points to provide more insightful analysis. 3. Formatting and styling: Customize the visual appearance of the stock chart by changing colors, styles, and
other formatting options to align with your preferences and branding. 4. Updating and refreshing data: If your stock data is dynamic and regularly updating, utilize Excel's data refresh feature to keep your stock chart up to date without manually editing the chart.Analyzing and interpreting stock charts Stock charts are an essential tool for investors to
analyze the performance of a stock over time. By identifying trends and patterns in the stock chart, investors can make more informed decisions about when to buy, sell, or hold onto a stock. A. Identifying trends and patterns in the stock chart Line charts are commonly used to track the price movement of a stock over time. By analyzing the direction
and steepness of the lines, investors can identify trends such as uptrends, downtrends, and sideways movements. Candlestick charts provide more detailed information about the stock's price movement, including open, high, low, and close prices. By analyzing the patterns formed by the candlesticks, investors can identify potential reversal or
continuation patterns. Support and resistance levels can be identified on a stock chart by looking for areas where the price has historically struggled to move above (resistance) or below (support). These levels can help investors anticipate potential price movements. B. Using stock chart analysis to make informed investment decisions By analyzing
stock charts, investors can identify optimal entry and exit points for a stock. For example, a stock chart may show a strong uptrend, indicating a good entry point, or a trend reversal pattern, prompting an exit from a stock. Stock chart analysis can help investors assess the risk associated with a particular investment. By identifying patterns such as
volatility or extended trends, investors can make more informed decisions about managing their risk exposure. Stock chart analysis can also aid in the formulation of trading strategies. For example, investors may use technical indicators such as moving averages or relative strength index (RSI) to identify potential buy or sell signals based on stock
chart patterns. Advanced Tips and Tricks for Stock Charting When it comes to creating stock charts in Excel, there are several advanced techniques that can enhance the visual representation of your data and provide valuable insights into stock performance. In this section, we will explore two advanced methods for improving your stock charting
capabilities. A. Adding Technical Indicators to Your Stock ChartTechnical indicators are powerful tools for analyzing stock price movements and identifying potential trends. By adding technical indicators to your stock chart, you can gain a deeper understanding of the stock's performance and make more informed investment decisions. 1. Adding a
Moving Average Click on the chart to select it. Go to the "Design" tab in the Chart Tools menu. Click on "Select Data" and then "Add" to add a new data series. Select the range of cells containing the moving average data. Click "OK" to add the moving average to your stock chart. 2. Adding Bollinger Bands Select the stock chart and go to the "Design"
tab in the Chart Tools menu. Click on "Select Data" and then "Add" to add a new data series. Choose the cells containing the Bollinger Bands data. Click "OK" to add the Bollinger Bands to your stock chart. B. Using Excel's Data Analysis Tools to Enhance Stock Charting CapabilitiesExcel offers a range of powerful data analysis tools that can be used
to enhance stock charting capabilities and gain deeper insights into stock performance. 1. Using the Analysis ToolPakThe Analysis ToolPak is an Excel add-in that provides a wide range of statistical and data analysis tools. You can use the Analysis ToolPak to calculate moving averages, exponential smoothing, and other statistical indicators to enhance
your stock chart. 2. Utilizing PivotTables and PivotChartsPivotTables and PivotCharts are excellent tools for summarizing and analyzing large amounts of data. You can use PivotTables to organize and analyze stock data, and then create PivotCharts to visualize the data in a clear and meaningful way.ConclusionRecap: Stock charts are an essential tool
for analyzing stock data and identifying trends and patterns. They provide a visual representation of stock prices over a period of time, making it easier for investors to make informed decisions.Encouragement: As you continue to explore Excel's charting features, don't be afraid to experiment and practice creating different types of stock charts. The
more you familiarize yourself with these features, the more confidently you can analyze and interpret stock data. The above stock chart in Excel example clearly shows what the final presentation would look like. The next thing that users or analysts must know is how to use this chart to read and interpret the data properly. The first thing to look into
is the opening price and the closing price.Some boxes have filled colors, and some do not. One must rely on these boxes to identify which are open and which are close prices.If its a non-filled box, the opening price is a downward arrow, i.e., the stock is profitable for the day.If its a filled box, the upward arrow is the opening price, i.e., the stock is
under loss for that day.The continuous line of an upward arrow indicates the high price for the day, and the continuous line of a downward arrow indicates the low price for the day.Using the stock chart, one can analyze the charts and make some interpretations. We have four stock charts available in Excel, below are the types.High Low Close, Open
High Low Close, Volume High Low Close, and Volume Open High Low Close.Based on the structure of the data, users/analysts can choose the appropriate one to show the numbers in the graph.This topic highlights key concepts and provides a broader understanding of the field. If youre curious to explore these ideas more thoroughly, this online
power query course offers a structured way to do so.
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